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Overview: 
Presentation software programs are easy-to-use and allow a presenter to professionally and 

visually present their ideas.  This workshop will introduce participants to the basics of 

presentation software such as PowerPoint, offer tips for creating professional presentations, 

options for accessing these software programs, and resources for getting help with using it.  

 

Learning Outcomes: 
Students will: 

• Understand the purpose of presentation software 

• Gain tips for making professional presentations 

• Identify options students have for using PowerPoint and other software programs 

• Find resources to help them become proficient with PowerPoint other software programs 

 

What is Microsoft PowerPoint? 
PowerPoint is a visual presentation tool that allows you to make professional/visual 

presentations. You can include images, videos, charts in your presentations. The following video 

demonstrates how PowerPoint can be used. 

https://support.office.com/en-us/article/video-what-is-powerpoint-5f9cc860-d199-4d85-ad1b-

4b74018acf5b 

 

Formatting Essentials 
The following are just a small number of formatting options available to you. These are 

presented because they will likely be the most needed for students.  For help with additional 

formatting topics, refer below to “Getting More Help”. 

 

These formatting essentials listed are from Microsoft PowerPoint. However, you may be using 

another word processing program, such as Google Slides. The good news is that it is not hard to 

translate this information to another software program because learning a second software 

program is like learning to drive a new car:  The hard part actually learning to drive. Learning a 

new car just means learning how to find and work things like the lights, blinkers, and wiper 

blades, etc. Different software titles that do the same thing, are like that. If you understand what 

the tool does and how to use it, finding it on another software program is usually very easy. 

 

Design: As you begin to create your presentation, you can choose from a variety of 

design styles that will give your presentation the look and feel that you want. While 

choosing between your options, be sure to review the title slide as well as the content 

slide to see how they look. The title slide is usually different from the content slides.  To 

choose between design options, click on the “Design” tab from the menu. Several options 

will be available from which to choose.  

 

Transitions: Once you are through creating all your slides, be sure to add a ‘transition’ 

style that displays when you move from slide to slide. You have many options from 

https://support.office.com/en-us/article/video-what-is-powerpoint-5f9cc860-d199-4d85-ad1b-4b74018acf5b
https://support.office.com/en-us/article/video-what-is-powerpoint-5f9cc860-d199-4d85-ad1b-4b74018acf5b
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which to choose. In order to create a unified transition for your presentation, start by 

choosing the “Slide Sorter” view. Then highlight all the slides by first clicking on the first 

slide, then hold the shift key while clicking on the last slide. All slides will be 

highlighted. Then choose a transition that you like by clicking on the “Transitions” tab on 

the menu. Also note the options available, such as the direction the transition goes 

(“Effect Options”), timed or not timed, and whether the slide advances based on a mouse 

click or is automatically timed.  

 

Embedding videos:  You can embed YouTube and other videos into your 

presentation so that you don’t need to move away from your presentation to show videos.  

To embed a video in a slide, click on the “Insert” menu option. Then click on the “Video” 

tab. You can either upload from your computer or enter a URL where the video can be 

found. 

 

Printouts: Presenters often need to provide handouts to teachers/audience members 

and more. Fortunately, this is an easy thing to do, and you have many options for printing 

your presentation out without too much trouble. Generally speaking creating a handout 

that has between three to six slides per page will be both readable, professional, and 

minimizes the number of pages you need to print.  You can print your presentation by 

following these steps:  Click on the “File” menu. Click on “Print”. Under “Settings”, 

Click on “Print all slides”. Then click on the drop-down menu that starts with “Full Page 

Slides”. This will give you options from which to choose how to print.  

 

Dos & Don’ts 
Do: 

Keep the look consistent:  Choose one design template format and stick with it 

throughout the presentation.  Avoid using more than one design on the different slides. 

Differing backgrounds distract the viewers from the message content.  

 

Keep text limited:  The general of thumb is to have no more than one idea per slide, 

six words per line, and six lines per slide. Of course, you can have less if that is 

appropriate, but not more.  

 

Use headlines -- not sentences: Each bullet point should be short and sweet. Use 

the minimum number of words to get the main idea across.  Take out unnecessary words, 

such as ‘the’.   

 

Keep transitions consistent:  When using transitions between slides, choose one 

style and stick with it.  As mentioned above, inconsistency in transitions distracts from 

your message and encourages your audience to notice the transitions instead.   

 

Present display in “Slide Show” view: You have several different ways to view 

your presentation: Normal (allows editing individual slides), Slide Sorter (to view all at 

once and to rearrange the order), Reading (displays in book style for easy reading), and 
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“Slide Show” view. The “Slide Show” view is the one you want to have up when you are 

actually making your presentation. The buttons for changing the view are in the lower-

right hand corner of the program.  

 

Don’t: 
Use visually-busy designs: Some of the preformatted designs may look visually 

stimulating but can be hard to read.  Keep the visual element simple, visually pleasing, 

and consistent. 

 

Use hard-to-read fonts: You have access to a wide variety of fonts, but not all are 

appropriate to use in presentations.  Overly artistic or exotic fonts are often hard to read 

and can look unprofessional.  As mentioned earlier, hard-to-read text will distract your 

readers from your message.  

 

Display blocks or paragraphs of text.  If you want to provide your audience with 

in-depth text, then provide that information in your handout. Allow them to read that 

information on their own. Too much text on the screen is hard to read. Using headlines 

and bullet points keeps your audience focused on the main point. 

 

Use sounds in transitions: They may seem cool at first, but after a few slides the 

novelty wears off and they become distracting and irritating.  

 

Where to Access MS PowerPoint 
As a student at Mt. SAC, you have several ways to access the various MS Office programs, 

including PowerPoint.  You can access it through the portal, go to a campus computer lab, you 

can install the software on your device, or you can subscribe to it online.  

 

Mt. SAC Portal 
Faculty, students and staff can access a free online version of MS Office (including PowerPoint) 

through the Mt. SAC Portal.  The link is in the upper right-hand corner of the main page once 

you log in. It is next to the link for the student email program, “Mountie Mail”. 

 

The portal also offers access to Google Slides as well. To access the Google Suite of software 

packages, open the “Mountie Mail” link which will take you to Gmail.  Once you are in Gmail, 

there is a grid-icon in the upper right corner of your screen. Click on that icon to access Google 

Apps. Google Slides is one of the apps available. Click on the link to access it.  

 

Campus Computer Labs 
If you don’t have a computer, or a specific software program to get your school work done, you 

can always go to one of the campus computer labs (see below) and use their software programs 

for free. Usually, you will only pay for any printing you do.   
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Buy Software to Install (or Download) on Your Computer 
You can make a one-time purchase of the software to install onto your computer or device.  

Purchase prices can vary greatly, costing up to $500 for the whole package. Fortunately, as a 

community college student, you have access to greatly discounted prices through 

CollegeBuys.org (see below).  You can get a complete copy of Microsoft Office for about 

$40.00. You can also buy the software at your local retail store, or directly from Microsoft Office 

website.  

 

Subscribe to Cloud-based MS Office 
As mentioned above, individuals can just pay a low monthly fee to use Microsoft Office.  The 

following link gives information about your subscription options.  

https://products.office.com/en-us/compare-all-microsoft-office-products?tab=2 

 

If you want more information, about the difference between MS Office 2016 and MS Office 365 

you can learn more. The following link has a great in-depth comparison between Office 2016 

(installed) and Office 365 (subscription). 

https://support.office.com/en-us/article/what-s-the-difference-between-office-365-and-office-

2016-ed447ebf-6060-46f9-9e90-a239bd27eb96?ui=en-US&rs=en-US&ad=US 

 

Get the Apps 
Microsoft Office does not have its own app, but each of the individual programs can be 

downloaded to your mobile device.  If you want to download the individual apps then go to your 

app store on your phone and type in the name of the program. You should be able to find a link 

for those products.  

 

Getting More Help 
Do you still need more help? 

 

Computer Lab Technician 
Still need help with PowerPoint?  Come to the Learning Lab (computer lab room) in Building 6, 

Room 101 and ask a technician for individualized help.   

 

Campus Help Desk 
If you still need more help, you can contact the Mt. SAC Help Desk at (909) 274-4357. 

 http://www.mtsac.edu/it/  

 

Take a Class 
If you want more detailed proficiency in Microsoft Office and/or PowerPoint, consider taking a 

class here at Mt. SAC.  Go to the campus catalog for more information. 

http://catalog.mtsac.edu/programs/coursesaz/cisb/ 

Credit-based classes: 

• CISB 51 Microsoft PowerPoint 

•  

Or you can take non-credit classes: 

https://products.office.com/en-us/compare-all-microsoft-office-products?tab=2
https://support.office.com/en-us/article/what-s-the-difference-between-office-365-and-office-2016-ed447ebf-6060-46f9-9e90-a239bd27eb96?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/what-s-the-difference-between-office-365-and-office-2016-ed447ebf-6060-46f9-9e90-a239bd27eb96?ui=en-US&rs=en-US&ad=US
http://www.mtsac.edu/it/
http://catalog.mtsac.edu/programs/coursesaz/cisb/
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• VOC BCPP1 - PowerPoint Basics 1 

• VOC BCPP2 - PowerPoint Basics 2 

• VOC CSB15 - Microcomputer Applications 

 

Other Resources: 
Do you not have access to the hardware and/or software you need to get your homework done? 

Don’t stress because there is support for your technology needs.   

 

On Campus Computer Labs 
Mt. SAC has several campus computer labs where you can use their computer equipment, 

software and print your documents. Most of these resources (except printing) are free for eligible 

students to use. Be sure to bring your student ID cards because most of these labs require it to 

use their equipment.  

http://www.mtsac.edu/computerlabs/ 

 

Technology Purchase Discounts 
Need to buy technology and/or software?  CollegeBuys.org is a great resource for getting 

discounts on technology, software, and accessories.   

http://foundationccc.org/CollegeBuys 

 

Summary 
Presentation programs allows students to make professional and visual presentations for school, 

work and other places. Following a few basic tips, users can maximize their presentation. 

Students have access to multiple resources for using and getting help with Microsoft PowerPoint 

and other presentation software.  

 

Reflection 
What did you learn from this workshop? 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

 

How can you use this information this week? 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

 

http://www.mtsac.edu/computerlabs/
http://foundationccc.org/CollegeBuys

